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Preface
PREFACE
                    

This manual EPT066750 is intended for use only with the following F-Series products:

WARNING: Invisible Class 4 Laser Radiation. Risk of personal injury.
                    

Read the manual before and when operating this laser system.

This product emits powerful invisible infrared laser radiation. A risk 
of personal injury or damage to equipment including fire may result 
if proper safety precautions are not obeyed.

F221i CP 10 STD F520i 10 STD F720i 10 STD

F221i CP 10 SHUTTER F520i 10 STD SHUTTER F720i 10 STD SHUTTER

F221i EP 10 STD F520i 15 STD F720i 15 STD

F221i EP 10 SHUTTER F520i 15 STD SHUTTER F720i 15 STD SHUTTER

F320i CP 10 STD F520i CP 10 STD F720i CP 10 STD

F320i CP 10 SHUTTER F520i CP 10 STD SHUTTER F720i CP 10 STD SHUTTER

F520i EP 10 STD F720i EP 10 STD

F520i EP 10 STD SHUTTER F720i EP 10 STD SHUTTER
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Preface
This manual has been produced for use in the operation of the Domino F-Series Laser 
Coder and to reinforce and complement any training program available with the product. It 
is not designed to replace any such training program.

For sales and service assistance please visit the following website and select “Contact 
Domino in your country” for local technical support:

http://www.domino-printing.com
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Preface
LASER SAFETY NOTICE

DANGER:
LASER RADIATION. Class 4 LASER PRODUCT. Risk of personal 
injury.

                    

Depending on the local installation environment, additional 
class 1 laser safety guarding may be necessary before the 
coder can be operated or made ready for use.

This is necessary to safeguard against accidental exposure to
direct or scattered radiation.

Guidance on creating and fitting laser guarding can be found in part
1 of the Product Manual.

Avoid eye or skin exposure to direct or scattered radiation.

Set up a laser safety zone and wear appropriate eye protection if 
laser radiation above class 1 may become available.
Information about the correct type of Protective Safety Goggles can 
be found within the Product Manual.

Contact with direct or scattered laser radiation can cause 
permanent damage to the eyes, including instant blindness. Laser 
radiation can also burn human tissue and start fires.

This product emits class 4 laser radiation from the laser aperture on 
the scan head.
This radiation is a pulsed, invisible, infrared laser radiation with a 
wavelength of 900 – 1200 nm, a maximum pulse energy of 2 mJ 
and CW Power of <175 W.

Before the product is used, make sure that fumes, particles and 
gases that are created during the coding process are safely 
removed. This can be achieved by installing an extraction system 
that is adapted to the planned coding process. 
EPT066750 Issue 5 August 2024 5



Preface
                    

                    

                    

DANGER: LASER RADIATION. Class 4 LASER PRODUCT. Risk of personal 
injury.

                    Do not use controls or adjustments of performance or procedures, 
other than those specified in this manual.
Do not apply changes or modifications that are not expressly 
approved by the manufacturer.
To do so may result in hazardous radiation exposure and may void 
the user's authority to operate the equipment.

DANGER:
LASER RADIATION. Class 4 LASER PRODUCT. Risk of personal 
injury.

                    Avoid eye or skin exposure to direct or scattered radiation.

Do not open the laser source.
The laser source (box inside the product) contains an embedded
laser device that emits invisible radiation in the region of 900 - 1200
nm with a total output power of up to 175 W. This radiation is not
accessible under normal use or service conditions. Opening of the
protective housing of the laser source box is only allowed for
special, according to the laser source manufacturer plans, trained
technicians.

WARNING: Class 3R Laser Radiation. Risk of personal injury.
                    

Avoid direct eye exposure.

This product emits a class 1 aiming beam as standard for F221i 
and F520i and class 3R for F720i and optionally provides class 3R 
laser radiation for aiming purpose from its laser aperture on the 
scan head.
This radiation is a visible red laser radiation with a wavelength off 
630 - 670 nm and CW Power of <1.4 mW.

This radiation can be dangerous to the eye if it is viewed directly. 
Avoid a direct exposure of the eye. It is not harmful to the human 
skin.
6 EPT066750 Issue 5 August 2024



Preface
                    

DANGER: LASER RADIATION. Class 4 LASER PRODUCT. Risk of personal 
injury.

                    Avoid direct eye exposure o direct or scattered radiation.

If the yellow beam delivery cable is damaged or overstressed it
may emit class 4 laser radiation while the laser source is energised!
Avoid to bend it to a diameter below <150 mm, to twist it more than
180 degrees or to stress it with repeated movement.

The beam delivery cable is not class 1 under a worst case single
fault, no cable break or fibre break detection is offered on this
product. The integrator must either include the beam delivery cable
inside the class 1 enclosure with the pulsed laser aperture or
undertake suitable measures to ensure that under reasonable and
foreseeable use the cable is suitably positioned to prevent it from
becoming damaged or mishandled.
EPT066750 Issue 5 August 2024 7
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Health and Safety
HEALTH AND SAFETY 

GENERAL
The F-Series laser coding systems are designed and built in accordance with international 
standards and other technical specifications, which are to be observed. The equipment 
conforms to current technology and approved safety requirements. 

This safety standard, however, can only be achieved if all intended and required measures 
have been taken and are constantly observed. It is part of the operator’s duties to plan 
these measures and check their continuing implementation.

Domino F-Series laser coding systems are produced by Domino Laser GmbH Germany. For 
special details contact your local support office. The F-Series laser coding systems have 
been developed and designed for fully automated coding of packaging materials and 
products by use of laser radiation.

The user must ensure that

• Depending on the local installation environment, additional class 1 laser safety
guarding may be necessary before the laser coding system can be operated or
made ready for use. The laser emits class 4 laser radiation from the laser
aperture on the scan head. 

• The equipment is only to be used for its intended purpose.
• The equipment is only operated in a good, serviceable condition, and that all

safety installations are regularly checked for their serviceability.
• Personal protective safety goggles for maintenance and repair personnel are

required and made available.
• Only suitable and approved tools and equipment are used.
• This User Guide is complete and in a legible condition at the equipment

location at all times.
• The valid rules and laws regarding accident prevention are available and

observed.
• Only according to Domino definitions sufficiently qualified and authorised

personnel shall operate, maintain, and repair the laser coding system.
These personnel are regularly instructed in all matters concerning appropriate
labour safety and environmental protection, and that they are familiar with the
operating manual, particularly the safety instructions contained herein.

• Any safety and warning labels on the laser coding system must not be removed
and must remain in a readable condition.
EPT066750 Issue 5 August 2024 11



Health and Safety
SPECIFIC DANGERS

Electrical Voltage
In the F-Series laser coding system, the maximum operating voltage is the connected 
mains voltage, which can pose a hazard to health. The mains voltage to be maintained is 
shown on the type label.

Work on live components must only be performed by authorised personnel.

In the case of a defective power supply, operation of the laser coding system is to be 
stopped immediately and is only to be repaired by authorised personnel.

Keep the controller closed at all times. Only expressly authorised personnel are permitted 
to open the controller.

Laser Radiation
Laser radiation can pose a risk to eyes and skin. The danger is not only posed by direct 
laser radiation, but also by scattered radiation and reflections from the work piece or the 
machine into which the laser is integrated. The degree of injury depends on the duration of 
the effect, the power and the wavelength of the laser.

Lasers and their installations are classified into seven laser protection classes, depending 
on their potential danger. Class 1 is the safest and class 4 is potentially the most harmful. 
These classes are defined in detail in EN60825: 2014 Part 1 and are summarised below:

                    

Class 1 Laser products that are safe during use, including long-term direct 
intrabeam viewing, even when exposure occurs while using telescopic 
optics. Class 1 also includes high power lasers that are fully enclosed so that 
no potentially hazardous radiation is accessible during use (embedded laser 
product). Intrabeam viewing of class 1 laser products which emit visible 
radiant energy may still produce dazzling visual effects, particularly in low 
ambient light.

Class 3R Laser products that emit radiation that can exceed the MPE under direct 
intrabeam viewing, but the risk of injury in most cases is relatively low. 
Dazzle, flash-blindness and afterimages may be caused by a beam from a 
class 3R laser product in the visible wavelength range, particularly under low 
ambient light conditions. This may have indirect general safety implications 
resulting from temporary disturbance of vision or from startle reactions.

Class 4 Laser products for which intrabeam viewing and skin exposure is hazardous 
and for which the viewing of diffuse reflections may be hazardous. These 
lasers also often represent a fire hazard.
12 EPT066750 Issue 5 August 2024



Health and Safety
Aiming Beam 
The system contains an internal aiming beam with a wavelength of 630nm to 670nm. 

This laser is a class 1 laser for F221i and F520i and class 3R for F720i. 

Harmful Dust and Vapours
When radiating materials by means of a laser, harmful dust and vapours can be produced. 
The user is responsible for appropriate measures, e.g. an exhaust system, to reduce such 
harmful dust and vapours to a level that complies with the allowed maximum concentration 
of pollutants at the work place.

Touching the Lens
Fused silica lenses are used in the F-Series laser system.

Lenses must not be touched.

If the lens has been soiled, it must be thoroughly cleaned before any operation.

Scan Head Mirrors
Never touch the mirrors of the scan head.

The mirrors are inside the scan head and there is a small risk of touching them when 
cleaning the lens.

When the mirrors have been touched accidentally thoroughly clean the mirrors.

Protecting the Lens
The scan head has a fused silica lenses that is accessible from the outside if the protection 
cap is removed.

This lens is protected by an aluminium frame, but the silica lens insert is fragile and can 
break and splinter if pressure is applied on it. Edges of the broken lens and loose splinters 
can lead to cut injuries or contamination.

Protect the lens with the protection cap while the system is installed, transported or not 
used for an extended time but always ensure the cap is removed before you use the laser.

If a lens is broken replace it immediately and make sure to safely remove all splinters to 
avoid cross contamination into other areas where silica particles may become a health 
hazard. Avoid touching the broken lens parts with the fingers. Use sticky tape to carefully 
collect all silica splinters and parts. Include the broken lens and the sticky tape in a strong 
plastic bag and dispose is in the normal waste container.
EPT066750 Issue 5 August 2024 13



Health and Safety
Noise
All systems emit during operation a noise level lower than 80dB(A). No personal protective
equipment against noise is needed. Local regulations may differ.

Crushing
There is a crushing hazard during installation and operation due to:

• Product moving along the laser head
• Products moving into and out of protective housing
• Doors and maintenance openings of protective housings

Especially prevent the risk of crushing.

Laser Coding Process
Potential fire risks could result from examples as listed below. This list is not considered to 
be complete. Local conditions must be considered as well.

• Coding on not specified material (e.g. easily inflammable or explosive materials)
• Invalid parameter settings (e.g. very low coding speed)
• Invalid parameter settings due to corrupted code data
• Coding constantly on the same product (e.g. no product movement caused by

various reasons)
• Inflammable gases or materials inside the working area

In coding mode the laser beam is controlled by software which must be considered as part 
of the risk assessment.

Note: Install a fire detector near the laser to monitor the coding process.

Velocity Kit Option
The fibre laser can be configured with an optional Velocity Kit for higher coding speed and 
therefore higher productivity. Once the laser is switched on there will always be a laser 
power output of below 5 mW. This enables an even faster start-up of the laser and thus 
high speed.

Note: This option requires hardware adoptions to be enabled in the software. 
14 EPT066750 Issue 5 August 2024



Installation
INSTALLATION

WATER COOLING
A factory fitted option is available to cool the laser head and controller with factory water or 
water from a water chiller. Use only clean and oil free water. 

                    

Hoses with an inner diameter from 3/8 inch (9.5 mm) to 10 mm may be used. Hoses have to 
be fastened with hose clamps. 

Maximum allowed water pressure is 5 bar. At a pressure higher than 5 bar, a pressure 
reducer must be installed on the inlet of the cooler and limited to 4 bar. The water flow is 
regulated automatically by a magnetic valve. The water flow, in the worst case (Coding Duty 
Cycle 97%, ambient temperature 45°, water temperature 27°) is 2 litres per minute. The 
water out of the controller has to be connected to one of the connectors of the laser cooling 
plate to cool the laser. The water out of the laser cooling plate is the final water out of the 
laser coding system.

An optional water chiller (part number L015148) is available from Domino. 

Controller Controller:
X28 Connector

Water In
(Cold)

Factory fitted option for 
water cooing

X28 Connection

Water Out
(Hot)
EPT066750 Issue 5 August 2024
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Installation
LIFTING AND MOVING THE CONTROLLER
                    

An optional mobility kit (Domino part number EPT031573) with 4 castors is available to 
assist moving the controller. 

For lifting, four hooks are supplied with the laser system which may be mounted to the four 
top corners of the controller (as shown below). 

WARNING: Heavy Equipment. Risk of injury.
                    

Two man lift required.

The controller weighs over 40kg.

4 hooks mounted to the top side of 
the controller
16
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Installation
LASER PROTECTION WINDOW
Domino recommends installing a protection window in front of the laser lens, to keep the 
lens clean. A protection window can be ordered from Domino - part number EPT031339. 
This protection window has to be checked and cleaned regularly (recommended daily) 
depending on the production rate. These intervals may be expanded afterwards. 

                    

WARNING: Sensitive material. 
                    

Exchange the windows if they can no longer be cleaned.
EPT066750 Issue 5 August 2024 17



Installation
GUARDING LABELS
The laser coding system is fitted with international laser warning signs and numbers of laser
performance data based on standard IEC 60825-1:2014 “Safety of laser products” during
manufacturing.

To ensure that the meaning of the laser warning symbols is understood, the laser safety
standard defines supplementary text on these signs to increase comprehension.

Signs with the supplementary text in English language are attached during manufacturing. 

It is mandatory to apply extra signs in the local language as defined in local standards (i.e.
the Machinery Directive for European countries) if the local language differs from English.
Check their presence and readability regularly. 

Warning signs and their locations on the laser coding system are explained in the Product
Manual. Refer to the topics “Mandatory Warning Labels for Installation” and “Local
Language Labels for Installation”. 

GUARDING
Guarding is an integral part of the laser safety.

Laser guarding must be constructed and certified by specialists that are trained and have
understood the use of the local laser regulations. The international standards mentioned
here are a good starting point but may not fulfil all local regulations.

This Domino laser coding system can emit class 4 laser radiation through the lens of the
scan head when the dual channel safety circuit is closed and the system is powered.

Before powering the system, ensure that the environment is securely guarded against
accidental exposure to direct or scattered radiation. You must also verify that the yellow
beam delivery cable is in good condition and either included in the secure laser guarding, or
other suitable measures ensure that under reasonable and foreseeable use the cable is
protected from becoming damaged or mishandled.

Inside the laser guarding, provide suitable measures against the risk that the laser energy
may act as an ignition source.

Domino recommends the following standards for assessing and constructing guarding: 

• ISO 12100:2010 “Safety of machinery - General principles for design - Risk
assessment and risk reduction“.

• IEC 60825-1 Safety of laser products - Part 1: “Equipment classification and
requirements and certify the guarding to be a laser class 1 guarding”.

• More detailed laser guarding information is available in the standard IEC 60825-4
Safety of laser products - Part 4: “Laser guards”.

• As your guard will be part of a machinery setup, the standard ISO 14120 Safety of
machinery – Guards – “General requirements for the design and construction of fixed
and movable guards” must be taken into account.

For additional support in planning and verifying laser guards, contact Domino.
18 EPT066750 Issue 5 August 2024



Installation
Beam Delivery Cable (Fibre)
The beam delivery cable is not class 1 under a worst case single fault, no cable break or 
fibre break detection is offered on this product. The integrator must either include the beam 
delivery cable inside the class 1 enclosure with the pulsed laser aperture, or undertake 
suitable measures to ensure that under reasonable and foreseeable use, the cable is 
suitably positioned to prevent it from becoming damaged or mishandled.The beam delivery 
cable has not been designed for robotic applications. The Laser must not be designed into 
systems where the Beam Delivery Cable will be subject to high levels of acceleration and 
twist, or combination thereof. If this is a requirement for the integration, please contact 
Domino to discuss the application in more detail.

The minimum bend radius for the fibre is 75 mm.

Interlock Switches
Interlock switches must be fitted to all access guards preventing access to the laser output 
lens and coding area that can be opened without the use of access tools.

Interlock switches must be wired into the laser control circuit so that the laser beam is 
disabled when the guard is removed.

Emergency Off
Integrate the laser into the emergency off circuit of the machine into which the laser is 
integrated. Install an emergency off push button near the laser coding systems which turns 
off the laser. Connect the emergency off push button via the interlock circuit to the 
controller.
EPT066750 Issue 5 August 2024 19
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Operation
OPERATION

F-SERIES LASER MARKING SYSTEM
                    

Optional 
TouchPanel 

Laser Key SwitchController On/Off Switch

Scan Head Laser Lens

Mains 
connector

Laser Head

Laser Fibre
EPT06
6750 Issue 5 August 2024
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Operation
CONTROLS AND INDICATORS
The User Interface, Indicator Lamps and Software icon functions are described in the 
following paragraphs:

TouchPanel and Interface
The software is operated via a PC keyboard, TouchPanel or Web Browser. The optional 
TouchPanel if connected, allows entry by touching the tabs and function keys on the 
screen. An onscreen keyboard is included in the software.

Note: The Web Browser does not support the message editor.

Controls
                    

ON / OFF BUTTON - Starts and stops the controller

KEY SWITCH - Starts and stops the Laser (fans and laser tube)

The key switch has three positions:

• “0” Laser off
• “1” Laser ready
• “*”  Laser start

Key switch

On/Off Switch
22
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Operation
Indicator LEDs Controller
                    

• Interlock 1 - Illuminates when the interlock 1 is closed
• Interlock 2 - Illuminates when the interlock 2 is closed
• PC Ready - Illuminates when the controller is ready for the laser to be started.
• Coder Ready - Illuminates when the laser is powered up and coding system is

ready to code
• Coder Busy- Illuminates when the laser is coding

The activation of the laser power supply is also indicated by two red (Power) LEDs on the 
front and one at the rear of the laser.

                    

Interlock 1

Interlock 2

PC Ready
Coder Ready

Coder Busy

 Power supply LED on the rear 
of the laser 
EPT066750 Issue 5 August 2024
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Operation
                    

To scan head

 Power supply LED on the front of 
the laser .

Shutter LEDs on the front of the laser  (only with shutter option) 
 Illuminates when shutter is open

Shutter LED

 Power supply LED on the fron
of the laser .

To scan head

Laser without Shutter Option

Laser with Shutter Option
24
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Operation
Indicators LEDs Fibre Laser
                    

Interlock Indicator 1 and 2
                    

Note: Within approximately 8 seconds after power up (boot phases of the safety relay) the 
display of both interlock LEDs is not valid.

Shutter Preparation / Error Indicator
                    

Both interlock 1 LED and interlock 2 
LED are GREEN

Interlock 1 and 2 respectively are closed.

LEDs are alternately flashing in RED 
colour

Wrong order was in the interlock loops e.g. open 
and close one loop only. Correct and restart the 
process.

The interlock has been opened while the shutter 
self-test was running.

Both interlock 1 LED and interlock 2 
LED parallel RED flashing

An electrical error (cross connection) was 
detected. Check wiring and restart the process.

Both Interlock 1 LED and interlock 2 
LED are lit RED

The safety relay is completely shut down. Power 
cycling is required.

Flashing GREEN Waiting for start command.

Lit GREEN Ready.

Lit RED A shutter malfunction is present.

Flashing RED A shutter malfunction was detected but is no more 
present.

Flashing ORANGE A shutter malfunction was detected - waiting for 
start command.

Lit ORANGE No shutter and shutter controlling is equipped.

Interlock Indicator 1

Shutter Preparation / 
Error Indicator

Laser Indicator 

Interlock Indicator 2

Shutter State / 
Error Indicator 
EPT0
66750 Issue 5 August 2024
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Operation
Shutter State / Error Indicator
                    

Note: The GREEN shutter preparation LED flashing is suppressed if one or both interlock is 
not closed.

Laser Indicator / Error Indicator
                    

LED Start-up Display on Power Up for Systems with Shutter
After power up, the laser unit will start an error test display in the following sequence:

• Shutter state error; each sec. means 10° Celsius of scan head temperature.
This display shows that the temperature sensor of the shutter housing is
properly connected, and that the LED works.

Then, approximately 8 seconds after power up: 
The 4 LEDs from top to bottom:

• Extinguish for a moment
• Light up (RED) for 1 second each, top to bottom
• Extinguish for a moment
• Display status as described above

If unauthorised changes are performed, the warranty will be invalidated.

Lit YELLOW Shutter is open, caution laser radiation is 
possible!

Lit RED Shutter temperature display (after power-up 
only).

Lit RED (permanent) Shutter feedback cross-check failed.

Flashing RED while the GREEN Shutter 
preparation LED is lit or flashing

Shutter is close to over temperature.

Flashing RED while GREEN shutter 
preparation LED is flashing

A shutter over temperature, or sensor fail 
(<10°C) occurred. Therefore the laser was 
switched off. Restart is possible.

Flashing RED while GREEN shutter 
preparation LED is off

A shutter temperature sensor fail (<10°C) is 
present. Therefore the laser is switched off.

Flashing RED while GREEN shutter 
preparation LED is off

A shutter over temperature is present. 
Therefore the laser is switched off.

Lit YELLOW Laser source ready for emission.

Lit RED (error) Laser is not (correctly) started.
26 EPT066750 Issue 5 August 2024



Operation
SWITCHING ON AND OFF
                    

                    

Switching On the Controller
At the controller switch the On/Off button from 0 to 1. Wait until the PC READY  
indicator has illuminated.

Switching On the Laser Head
Turn the key switch from position “0” to position “1”. To start the laser turn the key 
clockwise to the laser symbol and hold it for at least 1 second. The key automatically turns 
back to position “1”.

• The laser needs a warm-up phase of 3 seconds.

The CODER READY  indicator illuminates. After initialising the software and starting the 
laser, the coding system is ready.

Laser power is also displayed by a red LED on the rear of the laser head.

Switching Off the Laser Head
• Turn the key switch from position “1” to position “0”. The laser hardware is

switched off.

Switching Off the Controller
• At the controller switch the On/Off button from 1 to 0. The controller will

immediately switch off.

WARNING: Class 4 Laser. Risk of personal injury.
                    

Only use the laser coding system for its intended purpose.

Only trained personnel may operate the laser coding system.

Only operate the system with all required cables connected 
and all parts mounted.

Do not disconnect any cables during operation.

CAUTION: Risk of material damage.

                    Remove the lens cap before use.

It is used to prevent damage or external soiling that will cause a 
reduction in laser performance.
EPT066750 Issue 5 August 2024 27



Operation
F-SERIES CONNECTIVITY
The F-Series is operated either via a remote TouchPanel or via a PC running on Microsoft 
Windows 10® with installed QuickStep software.

To connect to one F-Series, the TouchPanel is connected to the X59 TouchPanel connector 
of the controller.

The TouchPanel then displays the UI relating to that coder.
                    

One TouchPanel can control multiple F-Series in the same network if required.

Details about the coder being controlled are displayed in the Home screen which lists: the 
logged in user, the coder’s name and the coder model. To connect to another coder in the 
network, follow the steps below:

(1) Disconnect from the current coder by pressing the Lock button and selecting 
Disconnect From coder to display the coders’ list screen

(2) Press the Lock button and select Unlock UI Settings, enter the password (QS)

(3) Press Settings, select Broadcast (default) as the connection method

(4) Go back to the coders’ list screen and press Refresh to view a list of all coders in the 
network

(5) Select the required coder

A list of favourite remote coders can be created, as follows:

(1) From the coder’s list screen, press the Lock button and select Unlock UI Settings, 
enter the password (QS)

(2) Press Settings and select Favourite as the connection method.

(3) Press Add Favourite and fill in the required fields manually or get a favourite coder 
from broadcast

(4) Select a coder from the Broadcast list

(5) Press Add to Favourites

X59 TouchPanel Connector
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Operation
Webserver
One may also connect to the coder’s UI via standard web browser. The following web 
browsers are supported:

• Microsoft Internet Explorer from version 9.0 on 
• Mozilla Firefox from version 22 on 
• Google Chrome from version 27 on
• Apple Safari from version 6 on

Not the complete functionality of the UI is available when connecting to the coders via a 
web browser.

Not available is:

The Message Editor which is accessed via Home Screen > Settings > Message Editor or via 
Home Screen > Messages > New Message / Edit coding Message

To connect, enter “http://[IP address of the controller]” in the address field of the web 
browser.
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Operation
QUICKSTEP INTERFACE

Home Screen
When powering up the coder and after login, the following Home screen is displayed.

                    

                    

Status Icons: Displays current status of coder, e.g:

Laser active
(Laser is busy - laser emission!)

USB device connected
(USB device connected to controller or TouchPanel)

Dongle connected
(Pharma or Service dongle connected)

Status Icons Status Bar Start/Stop Button

Lock

Main Menu 
Selection 
Buttons

Live Message 
Preview

Zoom Toolbar

Coder Name
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Operation
STATUS BAR
The status bar displays informal, warning and error messages - background colour of the
status bar:

•Green - the condition is normal, no action is required
•Amber - the condition is warning and may prevent coding, however if coding was

enabled and the reason for this fault has become obsolete it automatically re-enables
coding

•Red - the condition prevents coding and requires immediate correction

Note: Click on the status bar to acknowledge alerts.

Status Bar: Displays coder and alert status. If more than one alert is 
present, the highest priority alert is displayed.

Start/Stop Button: Enables coding

If the laser is switched off, it must be switched on before 
coding can take place.

Stops coding

Restarts the coder

Zoom Toolbar: Zooms in and out and the working area

Live Message Preview: Preview and main working area. Used for settings and 
message creation.

Main Menu
Selection Buttons:

Navigate to the four main QuickStep areas where all functions 
of the operational software can be accessed.

Lock Button: Locks the screen to prevent accidental changes

Login and logout

Disconnects from coder

Coder Name: Shows the coder which is being currently controlled
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Operation
General Functions
The following illustration shows the Global Coding Settings screen and the various screen 
areas.

                    

Click long on a button to get a description. Click long on a button of the Settings area to 
move this button to the Home screen.

Note: The breadcrumb navigation shows the current location inside the menu structure. 
One can switch the user interface level by clicking on the icons; it is also a quick way 
to return to the home screen from any page.

Status Icons Status Bar Start/Stop Button

Screen 
Title

Tabs

Breadcrumb navigation

Scroll By 
Page

Scroll By 
Line
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Operation
Initial Setup
The initial setup configures the overall look of the interface and also configures basic 
settings and presets for coder operation.

Display Settings
Home > Settings > Regional > Language and Keyboard

Set:

• Language
• Keyboard layout
• IME Scheme (Input Method Editor / Keyboard Layout)
• Primary currency

Setting the Master Clock
Home > Settings > Regional > Date and Time

Set:

• System date
• System time (24 hour clock)
• Time zone
• Automatic Daylight Saving Time
• Setup the Network Time Protocol

Security Management
Password protection prevents unauthorised changes to the software, and unauthorised
operation of the laser coding system.

Some functions can only be accessed from higher user levels; the higher the user level, the
more functions are available. The current user level is displayed in Quickstep home screen.

The functions that can be accessed for each user level are as follows:
                    

Extended system parameter settings can only be changed after entering the Administrator
password. This password is only known by employees authorised by Domino.

Note: If unauthorised changes are performed, the warranty will be invalidated.

Changing the passwords after the initial installation is recommended.

User Level Functions Password

Logout View the main functions none

Operator Start / stop coding, acknowledge alerts op

Supervisor Create/Edit messages; Change Coding 
Parameters; Access to Editor and Save Editor

sv

Administrator Edit most of the setup Not published
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Operation
Creating and Editing a Message

Add Text
(1) Select Messages > New Message or Settings > Message Editor to open the 

Message Editor.

(2) Press on the screen within a specific area of the Message Editor where you require 
the item to appear. A cross hair will appear at this location.

(3) Select the Add  icon.

The Add sub-menu displays.
                    

(4) From the sub-menu select the Text  icon.
Change keyboards by selecting the appropriate Alternative Keyboard icon at the 
bottom of the text entry screen.

(5) Enter the required text using the keyboard and select the green tick icon when 
finished.

(6) To change text, select the text item and then the Keyboard icon on the Edit sub-
menu.

(7) To change text parameters (Object Name, Position, Bold, Width etc.), use the sub-
menu (Font, Alignment) or select More…

(8) To delete an object, select the object and select the delete  icon of the Edit 
menu.

(9) Activate the message for coding by sending it to the coder  via the File menu 
.

Text Barcode
(MRC)

Graphic Shape Clone Item
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Operation
Add a New Barcode
To add a barcode to the message:

(1) Press on the screen within a specific area of the Message Editor where you require 
the item to appear. A cross hair will appear at this location.

(2) Select the Add Barcode  icon and select the type and specification required 
from the list and editable text boxes.

(3) Use the Text, Variable, Edit Variable and Properties tabs to enter the barcode data.

(4) Select the green tick icon to insert the code into the message.

(5) Edit the barcode by highlighting the barcode within the message and using the sub-
menu or by selecting More…

(6) Activate the message for coding by sending it to the coder  via the File menu 
.

Add an Image
To insert an image into the message:

(1) Press on the screen within a specific area of the Message Editor where you require 
the item to appear. A cross hair will appear at this location.

(2) Select the Image  icon from the Add menu.

(3) An images folder stored in the coder will open.

(4) Browse for the required image.

(5) Select the green tick icon to insert the image.

Monochrome Bitmap (*.bmp), DXF (*.dxf) (up to Version 12, information about 3-
dimensional objects is discarded, fonts and labels are not supported) and Hewlett Packard 
Graphics Language HPGL (*.plt) black white graphic file formats are supported.
Supported commands for HPGL import are: Arc Absolute, Arc Relative, Plot Absolute, Plot 
Relative, Pen Up, Pen Down

(6) Select the Move  icon to move the copied item to the desired location within the 
message.

(7) Activate the message for coding by sending it to the coder  via the File menu 
.

Use the File Manager (Home > Settings > File Manager) to copy an image from a USB 
device to the controller.
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Operation
Add a New Variable
Message or system variables may be added. Message variables may only be used in the 
message in which they have been created. System variables can be used in all messages.

• Message variables are created via Home > Settings > Message Editor >

Add  > Text  > Add Variable .

• System variables are created via Home > Settings > Message Editor >

File  > Add/Edit Variable  > Add Variable .
Note: System variables are referenced within message via a link. Insert a link into a 

message to use a system variable.

The following variables can be created and added to the message:

• Clock (message & system)
• Counter (message & system)
• Prompted Field (message only)
• Link (message only)
• Script (message only)
• Coding (message only)
• Shift Code (message only)
• Text Insert (message & system)
• Text Variable (message & system)
• Text Link (message only)

Notes: (1) System variables are emptied on a power cycle.

(2) All steps below are described for local variables as they are the same for 
system variables.

Add a New Clock
To add a new offset clock to the message:

(1) Press on the screen within a specific area of the Message Editor where you require 
the item to appear. A cross hair will appear at this location.

(2) Select the Add  icon.

(3) From the sub-menu select the Add Text  icon.

(4) Select +Variable > +Create New > Clock.

(5) The scope cannot be changed - use the File menu to create a global clock.

(6) Enter a name for the clock or use the default name and use the new screen to select 
the format.

(7) Select the required offset parameters (Days, Months, Years and/or Hours, Minutes, 
Seconds and/or Weeks) and add values using the keyboard. Select the green tick 
icon when each parameter is completed.
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Operation
(8) Review the entered information and select the green tick icon if correct or press in 
the required field to add or change values.

(9) Select the green tick icon to enter the offset clock into the message.

(10) Activate the message for coding by sending it to the coder  via the File menu 
.

Add a New Counter
To add a new counter to the message:

(1) Press on the screen within a specific area of the Message Editor where you require 
the item to appear. A cross hair will appear at this location.

(2) Select the Add  icon.

(3) From the sub-menu select the Add Text  icon.

(4) Select +Variable > +Create New > Counter.

(5) The scope cannot be changed - use the File menu to create a global counter.

(6) Enter a name for the counter and enter the Format String “N” for numerical and “A” 
for alpha characters.

(7) Select a Leading Character Mode from the drop down options: None, Blank or 
Custom. If a custom character is selected in the Leading Character box, enter the 
character required.

(8) In the Step Control box, select the option required to activate the increment:
Coding Start
User Input (Rising Edge)- specify the User Input to be used
User Input (Falling Edge)- specify the User Input to be used.

(9) In the External Reset box, select 
None,
Coding Enable,
Application Start
Message Load 
User input Rising Edge
User input Falling Edge.

(10) In the Counter Repeat box, enter the number of items to be coded before the 
counter increments (default value is ‘1’).

(11) Step Size sets the increment value of the selected counter from 1 to 99999. The 
default value is ‘1’.

(12) Set the current value in the selected alphanumeric format of the counter.

(13) Set the start value in the selected alphanumeric format for the counter. If the start 
value is larger than the end value the counter will count backwards.
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Operation
(14) Set the end value in the selected alphanumeric format of the counter.

(15) Edit, if required, the Alpha Field String. to be used for the alpha designators in the 
counters. All alphanumeric characters are available for use in this string. The 
maximum string length is 26 characters. The default string is A to Z (including all 
characters).

(16) Select an Ending Action: Select 
None
Disable, User Output  
User output and disable
Select the User Output if activated.

(17) If required, set a Batch Link to another counter when this counter has it’s end value 
and select the linked counter from the drop down list.

(18) Review the entered information and select the green tick icon if correct or press in 
the required field to add or change values.

(19) Select the green tick icon to enter the counter into the message.

(20) Activate the message for coding by sending it to the coder  via the File menu 
.
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Operation
Add a New Prompted Field
Prompted text fields may be inserted into messages. The content of these text fields is 
entered in QuickStep after sending the message to the coder.The content format has to be 
specified when creating these text fields in a message in the Message Editor.

To add a new prompted field to the message:

(1) Press on the screen within a specific area of the Message Editor where you require 
the item to appear. A cross hair will appear at this location.

(2) Select the Add  icon.

(3) From the sub-menu select the Add Text  icon.

(4) Select +Variable > +Create New > Prompted Field.

(5) Enter a name or use the default name for the prompted field object.

(6) Set a default value in the format matching the input mask for the prompted field.

(7) Enter a prompt which is displayed on screen when the data for the prompted field 
should be entered. (After sending the message to the coder).

(8) Select an input mask for the prompted field which specifies the type of content for 
the prompted field.Possible formats:

(9) Review the entered information and select the green tick icon if correct or press in 
the required field to add or change values.

(10) Select the green tick icon to enter the prompted field into the message.

(11) Activate the message for coding by sending it to the coder  via the File menu 
.

Mask Description

0 Mandatory numeric character 0-9 

9 Optional numeric character 0-9 

L Mandatory alpha character A-Z or a-z 

? Optional alpha character A-Z or a-z

A Mandatory alphanumeric character 0-9, A-Z or a-z 

a Optional alphanumeric character 0-9, A-Z or a-z 

C Mandatory any character 

c Optional any character 

# Optional currency symbol €, $, £ or ¥ 

& Mandatory any character or space 
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Operation
Add a New Link
To add a new link to the message:

(1) Press on the screen within a specific area of the Message Editor where you require 
the item to appear. A cross hair will appear at this location.

(2) Select the Add  icon.

(3) From the sub-menu select the Add Text  icon.

(4) Select +Variable > +Create New > Link.

(5) Enter a name or use the default name for the link object.

(6) Specify the source of the link, e.g. a counter or a clock or message content element. 
System variables are entered into a message via a link.

(7) Select the green tick icon to enter the link into the message. The link object will have 
the same content as the source object.

(8) Activate the message for coding by sending it to the coder  via the File menu 
.

Undo / Redo
                    

Undo or redo the last editing steps in the message editor including change of settings or 
parameter settings.

Note: Creating a new message clears the undo cache - no undo to the last message is 
possible.

Undo Redo
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Operation
Message
                    

•New Message 
Creates a new message.

•Save 
Saves the current message in a selected message store.

•Save as 
Saves the current message with a given name in a selected message store.

•Coding 
Selects a source for the coding variable.

•Laser Parameters 
Create, delete and edit laser parameter sets.

•System Variables 
Create global variables.

•Message Properties 
Message settings overwrites system settings of Fields, Coding on the Fly, Vector
Sorting and activate usable fields. Also enables the user to activate Optical Correction,
Tube Distortion and PN Transformation.

•Send to Coder 
Sends the current message to the coder and activates it for coding.

New 
Message

Save

Save as

Coding

Laser 
Parameters

System 
Variables

Message 
Properties

Send to 
Coder
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Operation
Edit
                    

•Edit Text 
Opens the keyboard to edit the text content

•Select Font 
Opens the list of available fonts to select a font

•Alignment 
Sets the alignment of the object

•Edit Object Properties 
Allows editing the properties of the object

•Laser Parameters
Set laser parameters for the object

•Cone Item
Duplicates the object

•Delete Object 
Deletes the selected object

Add
                    

Edit Text

Select 
Font

Alignment

Edit Object 
Properties

Delete 
Object

Edit menu for a text object.

Laser 
Parameters

Clone

Text Barcode
(MRC)

Image Arc
Rectangle

Clone Item
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Operation
Move
                    

Select an object in the editor by clicking on it and move it in the desired direction by clicking 
on the arrow icons.

Drag and drop can also be used.Select and hold the item within the message and move it to 
the desired location.

Zoom
                    

To view the item(s) in the Message field, or the whole Message field in a different size, select 
the item(s) and then select the appropriate button from the above toolbar:

• Incrementally zoom in on the message area
• Incrementally zoom out of the message area
• Fit whole message height to area
• Fit whole message width to area
• Zoom to 100% (actual size) of Message
• Zoom selected item to fit into message area

Re-order Visual Items
                    

Sets the order of objects to code.

Select an object of the list and use the arrows to change the order.

Zoom in

Zoom out

Fit height

Fit Width

Zoom 100%

Zoom to 
Item
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Operation
Item Selection List
                    

Selects multiple or all objects of a message. Select the items of the list to be selected. Or 
click on “Select all” to select all objects. Click on “Clear Selection” to have no object 
selected.

Resize
Resize an object by selecting it and dragging the red mark of the object.
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Operation
MESSAGE STORE AND FILE MANAGEMENT

Selecting an Existing Message
Note: Where no message is selected for coding, no live message will be displayed in the 

Home screen.

(1) Select the Messages button to open the Message Store.

(2) Select the required message from the list.

(3) Choose to Edit, Preview or Send to Coder.

Note: Send to Coder will revert to the Home screen. The selected message will then be 
displayed.

File Manager
Home > Settings > File Manager

File Manager is a useful way of reviewing and organising stored messages, images and 
scripts.

Using File Manager it is easy to rename files, create new folders and copy content between 
folders.

                    

New Store: Create a new store for messages, images and scripts.

Note: A new message store can only be created in the messages folder. 

Edit: Rename

Copy

Cut

Delete

Details

Paste: Used with the Copy/Cut commands to add files into folders.
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Maintenance
MAINTENANCE

CHECKING FANS AND AIR VENTS
                    

The fans are located at the bottom of the controller.

A fan defect immediately poses a danger of overheating that may result in damage to the 
BCP7 controller, therefore the fans must be checked once a month.

Controller 
(1) Check the fans for bearing noises. If bearing noise exist, the respective fan must be 

replaced.

(2) Check the fan filters of the controller (2 on the left side and 2 on the right side) for 
blockages and dirt. If necessary, exchange them. This may be easily done from the 
outside without opening the controller.

WARNING: Mains electricity. Risk of death.
                    

Switch off and un-plug before undertaking any work on the 
laser coding system.
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Maintenance
CLEANING THE LENS
                    

                    

The lens must be checked monthly for dust, and if necessary be cleaned with (absolutely 
clean) compressed air from a can.

For all other dirt, the lens must be cleaned with 99,9% Isopropyl Alcohol and the Domino 
lens cleaning kit. The kit consists of two parts (both are needed):

• EPT033842 - SP Lens Cleaning Cotton Balls (Set of 50)
• EPT033843 - SP Lens Cleaning Cotton Swabs (Set of 100)

Cleaning procedure as follows: 

(1) Take an unused cotton ball and soak it in Isopropyl Alcohol.

(2) Lightly wipe with ONE PASS ONLY across the surface of the lens.

(3) Inspect the cotton ball. If dirt or oil is present, repeat steps (1) to (2).

(4) Take an unused cotton swab and soak one end in Isopropyl Alcohol.

(5) Lightly wipe across the border area of the surface of the lens.

(6) Inspect the cotton swab. If dirt or oil is present, repeat steps (4) to (5).

(7) Use an unused cotton swab to lightly wipe excess liquid from the lens.

CAUTION: Risk of Material Damage

                    Do not use compressed air from the installation for cleaning.

Do not use water for cleaning. The lenses are not water resistant.

Clean carefully. There is a risk of scratch marks on the lens which 
will reduce the coding quality.

WARNING: Mains electricity. Risk of death.
                    

Switch off and unplug from the mains before undertaking any 
work on the laser coding system.

Ensure the mains power plug is removed before cleaning the lens.
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Maintenance
GENERAL CLEANING
                    

The outer surfaces may be cleaned with a damp cloth and a mild cleaning agent only. No 
humidity must get into the system.

WARNING: Mains electricity. Risk of death.
                    

Switch off and un-plug the mains supply to the laser coding 
system and the connected installation.
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Maintenance
SERVICE: REPLACEMENT OF COMPONENTS

Applications without Shutter
                    

Applications with Shutter
                    

Shutter Safety Relay
                    

Maximum cycles of Safety Relay PNOZ S4

(opening of guard door when laser is coding)

15 Million

Maximum cycles of Safety Relay PNOZ S4

(opening of guard door when laser is not coding)

100 Million

Maximum cycles of Shutter 10 Million

Maximum cycles of Safety Relay 10 Million
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Fault Finding
FAULT FINDING

SYSTEM STATUS MESSAGES
                    

Status Message Cause Suggested Action

11 Product left coding 
area (moving too 
fast?)

The message has not been 
completed in time.

Slow down the conveyor, 
reduce the coding time, or 
move the text upstream on 
the field.

12 Product left coding 
area (moving too 
fast?)

The message has not been 
completed in time.

Reduce the coding time or 
move the text upstream on 
the field.

13 List buffer repeat 
count fail.

Internal Fault. Restart the system. 
Contact Domino.

14 Maximum code to 
code distance 
exceeded.

The maximum distance 
between coding trigger 
signals has been exceeded 
and an expected coding 
trigger was not received.

Restart the system. 
Contact Domino.

15 Coding trigger 
signal ignored.

A coding trigger has been 
received too soon after the 
previous.

Restart the system. 
Contact Domino.

16 Maximum laser on 
time exceed (laser 
disabled by 
hardware).

The laser has been firing for 
longer than expected.

Restart the system. 
Contact Domino.

17 Laser warm up. A short warm up period is 
required before use.

Restart the system. 
Contact Domino.

30 Scan head power 
missing.

There is no +/-15 V at the 
scan head, or no data 
returning from scan head.

Restart the system. 
Contact Domino.

31 Scan head 
temperature out of 
valid range.

The scan head is cold. Restart the system. 
Contact Domino.
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Fault Finding
32 Scan head 
warming up -
please wait.

The scan head is cold. Wait for the heaters in the 
scan head motors to warm 
the scan head, the coder can 
be used but you may 
experience very minor 
position errors.

33 Controller over 
temperature.

The temperature in the 
controller is very cold or too 
hot.

Check that the fans are 
working and that the filters 
are not blocked.

51 Controller near 
over temperature.

The controller is getting quite 
hot.

Check that the fans are 
working and that the filters 
are not blocked.

56 coder ready to 
code.

coder will code if a coding 
trigger signal arrives.

Information Only.

58 No Message 
loaded

There is no valid message 
loaded into the controller.

Load a message and send it 
to coder.

549 Turn keyswitch to 
enable coding

The safety relay needs to be 
set after an interlock has been 
opened.

Turn keyswitch to start 
position, or give a remote 
start input (the “Play” button 
on the UI will not function).

550 System disabled The keyswitch is at position 0. Turn the keyswitch to 
position 1.

551 Aiming turned on The aiming beam, 
configurable in the global 
settings, is turned on.

Information Only.

552 External Interlocks 
Open

The interlock or interlocks are 
open.

Close the guards to 'make' 
the interlocks.

553 External Interlock 1 
Open

The interlock switch 1 is open Close the guards to 'make' 
the interlocks.

554 External Interlock 2 
Open

The interlock switch 2 is open Close the guards to 'make' 
the interlocks.

555 Air Fault Not enough air flow to cool 
the laser.

Check the air regulator filters 
and pressure settings.

Status Message Cause Suggested Action
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Fault Finding
Note: For all other errors or messages contact Domino.

556 Vacuum Fault The DPX is not running. Make sure the DPX is 
serviceable and running.

557 Filter not ok The DPX filters are blocked. Change the DPX filters.

578 System Standby The keyswitch is at position 1 
but not yet set by turning the 
keyswitch or remote start.

Turn the keyswitch to start 
position, or give a remote 
start input, or press the 
“Start” button on the user 
interface.

579 coder enabling. The laser is switched on but 
warming up.

Wait for the coder to be 
ready.

580 Inconsistent Laser 
On State

The laser start input level is 
being overridden by a user 
interface laser on selection or 
by a fault message.

Restart the system. 
Contact Domino.

581 Next controller not 
ready

The next controller in a 
“chain” in a Multihead 
configuration is not ready.

Restart the system. 
Contact Domino.

582 Controller Idle 
(Multi Head 
System)

The system is part of a multi 
head “chain” but has been 
disabled (see install options). 
This is for information only.

Restart the system. 
Contact Domino.

583 External Interlock 
has been opened

One or both interlocks was 
opened but is now closed.

Restart the system. 
Contact Domino.

594 Safety Relay Fault There was a laser start 
command present while one 
or both (CAT3/4) interlocks 
where not closed.

Make sure the interlocks are 
closed before giving the laser 
start input.

Status Message Cause Suggested Action
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For additional documentation, including other available languages,
either scan the QR code, or go to
https://mydomino.domino-printing.com
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